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TOPIC 1.0 : WORD PROCESSOR 

 

INTRODUCTION OF MS WORD 

Ms Word User Interface 
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Features of Ms Word You Should be Using : 

 

1) Checking Your Spelling 

 

You can correct your spelling errors by running a full Word spell check from the 

Review tab, Proofing group, Spelling and Grammar button (or press the F7 keyboard 

shortcut). Suggestions will be presented below with the first suggestion selected. 

The options you have are similar to the right-click options available for corrections as 

you type. 
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2) Utilizing The Benefits Of Mail Merge 

This features allows us to send out bulk emails, but consequently with unique 

elements. For example, we could produce a series of labels or envelopes for a large 

mailing, an email or letter that includes names and addresses. Users simply create 

one document that contains the information that will be the same in each version, 

and then add placeholders for the information that will be unique to each version. 

 

 

 

3) Find & Replace Function  

Word Replace can search for all occurrences of a particular word, phrase or set of 

characters and replace them with an alternative. 
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4) Inserting Watermark 

If you’re submit an important document and you want to protect your content 

without having to edit much of it. You can insert a watermark specific to your 

objectives via the page layout button. You can also customise your own watermark, 

and also insert your own picture or your brand logo, for your reports. 
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EXERCISE 1 

(Produce documents, inserting page, formatting procedures, setting up column, creating 

tables, inserting graphical into column) 

 

TASK 1 : 

1. Create a new document and insert the content as below. Save your document as 

Exercise 1 DBC20012. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Change the font type, font size and font color of your text 

3. Insert a section break and start the new section on the next page. 

TASK 2 : 

1. At the page 2, type “TASK 2” at top of the page 

2. Copy the Task 1 text and paste in under your TASK 2 

3. Setting 2.0 lines for your line spacing of your text 

4. Insert header and footer for your page : 

FOODS TO BOOST BRAIN FUNCTION 

Your brain is kind of a big deal. The foods you eat play a role in keeping your brain 

healthy and can improve specific mental tasks, such as memory and 

concentration. 

 

 Oily Fish 

Oily fish are a good source of omega-3 fatty acids. Omega-3s help build 

membranes around each cell in the body, including the brain cells. People 

with high levels of omega-3s had increased blood flow in the brain. 

Examples of oily fish that contain high levels of omega-3s include : 

 Salmon 

 Mackerel 

 Tuna 

 Sardines 

 

 Dark Chocolate 

Dark chocolate contains cocoa, a type of antioxidant. Antioxidants are 

especially important for brain health, as the brain is highly susceptible to 

oxidative stress, which contributes to age-related cognitive decline and 

brain diseases. One study found that participants who ate chocolate 

experienced increased positive feelings, compared to participants who ate 

crackers 
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Header : DBC20012 – Computer Application 

Footer : Exercise 1 & page number 

5. Split your text into two column. Then, add a line between the column 

6. Add a Drop Cap in your text 

7. Add the text watermark at your page. Your text watermark must be your name. 

8. Apply the page color for your page. You can choose any attractive color and 

compatible with your work. 

9. Then, apply the page border for your page. 

 

 

 

 

 

 

 

You can refer the below figure as your guideline 
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TASK 3 : 

1. At page 3, create a table with 3 columns and 2 rows. 

2. Type the content of the table as below. 

3. Insert a picture for each Food Group 

4. Then, convert the table to text 

(Under Table Tools > Click Layout > in the data group > click Convert to Text) 

5. Change the title “Food & Energy” using WordArt 

 

Food & Energy 

Food Group : Cereals 
 
Example : Rice, wheat, bajra 
 
Function : Supply mainly 
energy, supply proteins and 
fats, supply iron, thiamine 
and fibres  
 

Food Group : Milk and milk 
products 
 
Example : Milk, butter, 
curds, cheese 
 
Function : Supply proteins, 
fat, calcium and vitamins 
 
 

Food Group : Fruits and 
vegetables  
 
Example : Papaya, mango, 
carrot, pumpkin 
 
Function : Supply vitamins, 
minerals, iron and fibres 
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EXERCISE 2 

 (Applying references, adding document protection) 

TASK 1 : 

1. Create a new document and type the passage below. Save your document as 

Exercise 2 DBC20012 

 

 

2. Insert Endnote at the end of your first paragraph. Type your Endnote as “ source 

from www.wikipedia.org 

3. Insert Footnote at the end of the second paragraph. Type your Footnote as “ DPM 

Polytechnic KPM” 

 

 

  
4. Change the numbering format for your Endnote and Footnote 

Endnote : a,b,c … 

Footnote ; I,II,III,… 

 

 

 

What is the difference between 

Endnote and Footnote? 
Endnote – located at the end of the 

document 

Footnote – located at the end of the 

page 

Management in business and organizations is the function that coordinates the efforts of 

people to accomplish goals and objectives using available resources efficiently and 

effectively. Management comprises planning, organizing, staffing, leading or directing, 

and controlling an organization to accomplish the goal. 

The Diploma in Business Studies provides a comprehensive basis for a career in business 

while being flexible enough to let you pursue areas that particularly interest you. It is 

designed to equip you with the skills and self-confidence to effectively manage and adapt 

to a wide range of competitive and constantly changing business environments. 

Diploma in Business Studies offer graduates an attractive career. The popular careers 

that have been chosen by the graduate are consulting (25%), teaching (20%), bank 

management (40%) and investment banking (15%). 

 

http://www.wikipedia.org/
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5. Add a caption for the polytechnic’s logo 

 Select the object that you want to add a caption to. 

 On the References tab, in the Captions group, click Insert Caption. 

 In the Label list, select the label that best describes the object 

6. Insert comment for the passage 

 On the Review tab, select New Comment 

 To show revision in balloon :  

From the Review tab, click Show Markup  Balloons  Show Revisions  in 

Balloons. 

7. Save your document as Exercise 2 DBC02012. Apply protection to your document 

using Mark document as final  

8. In an open document, click File > Info > Protect Document. You will see the following 

options.  
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TOPIC 2.0 : SPREADSHEET 

 

INTRODUCTION OF MS EXCEL 

Ms Excel User Interface 
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 Quick Access Toolbar 

The Quick Access toolbar gives you quick access to 
frequently used commands. This toolbar is completely 
customizable and can be positioned above or below the 
ribbon commands. 
 

Tabs 
Groups of like commands are organized under tab names. 
Click a tab to view the commands in the ribbon. 
 

Ribbon 
Displays tab commands organized into groups. If you click 
the different tabs, you will see the commands change. 
 

Name box 

Every cell has a name in the format <ColumnRow>. The 
name of the currently selected cell, called the active cell, is 
shown in the Name Box 
 

Formula bar 

The Formula Bar allows you to enter data in a cell. Data can 
be alphanumeric, pictures, symbols, or (as the name 
suggests) formulae 
 

Working area / cells 
The data contained in the file will be shown here 
 

Worksheet tabs 

Every Excel file is properly referred to as a workbook. A 
workbook can contain one or more worksheets. Click these 
tabs to switch between the different worksheets. 
 

Scroll bar 

As you grow more accustomed to working with Excel, use 
these scroll bars to scroll horizontally or vertically through 
the data. 
 

Column 
Run vertically and are identified by letters in the column 
header 
 

Row 
Run horizontally in a worksheet and are identified by 
number in row header 
 

 

  

 

  

 

  

 



DBC20012 Computer Application 

Exercise & Lab Works 
17 

4 Powerful Excel Functions That Make Work Easier 

 

 

The sum function is the most used function when it comes to computing data on Excel. This 

function is performed by typing the formula on the function bar and highlighting the cells 

that you want summed before clicking “Enter”. You also need to be careful in highlighting 

cells, as Excel will sum everything you include. 

 

 

 

 

Text function is a esuful tool that helps convert a date (or number) into a text string in a 

particular format. It falls in the category of string formulas that converts numerical values to 

a string. It is handy when users need to view numeric data in a readible format. Take note 

that the “TEXT” formula only works to convert numeric to text. 

 

 

 

The SUM Function 

The TEXT Function 
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VLookup is powerful Excel function that is often overlooked. Users will find it useful when 

they need to find specific data on a large table. You can also use VLookup to search for 

names, phone number, or specific dataon your sheet. Instead of manually looking for the 

names and wasting time scrolling through hundreds of data, the VLookup function makes 

this process faster and more efficient. 

 

 

 

The average function is an extremely useful tool for getting the average value in a range of 

cells. Like the sum function, it is frequently used in computing and analyzing data on 

spreadsheet. Basically, the average function works to find the “arithmetic mean” for a group 

of cells. Aside from the average function, Excel also has the median and mode function. 

 

 

 

 

The VLOOKUP Function 

The AVERAGE Function 
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EXERCISE 1 

(Spreadsheet environment, entering and editing data, formatting cell, perform function 

features, perform chart features and graphics features) 

TASK 1 : 

1. Create a new file, save as Exercise Excel. 

2. Type the data below (start on cell A1) 

3. Rename the sheet 1 as Task 1 (Right click on sheet 1 > Rename) 

 

Staff Number Name Basic Salary 

M001 Riduan Ahmad RM2,300.00 

F023 Asyikin Arif RM1,800.00 

F030 Alia Zulaikha RM2,500.00 

M012 M.Sarajeevan RM1,900.00 

F028 Che Zaiton Mohd  RM1,500.00 

M035 Alif Fitri RM2,000.00 

M040 Zakuan Idham RM2,200.00 

F001 Mastura Ismail RM2,150.00 

M009 Wan Mohd Hafiz RM1,700.00 

F026 Mawar Danish RM2,150.00 

 

TASK 2 : 

1. Copy Task 1 to a new sheet. (Right click on Task 1 > Move or Copy Sheet > Create a 

Copy) 

2. Rename Task 1 (2) as Task 2 

3. Use the Home tab to change the font, font size, font style, font color and make a 

border. 

4. Fill color in the table 

Staff 

Number 
Name Basic Salary 

M001 Riduan Ahmad RM2,300.00 

F023 Asyikin Arif RM1,800.00 

F030 Alia Zulaikha RM2,500.00 

M012 M.Sarajeevan RM1,900.00 

F028 Che Zaiton Mohd  RM1,500.00 

M035 Alif Fitri RM2,000.00 

M040 Zakuan Idham RM2,200.00 

F001 Mastura Ismail RM2,150.00 

M009 Wan Mohd Hafiz RM1,700.00 

F026 Mawar Danish RM2,150.00 
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TASK 3 : 

1. Copy Task 2 to a new sheet. 

2. Rename Task 2 (2) as Task 3 

3. Insert column, and type the data as the table below (Right click on Column label > 

Insert) 

4. Insert a new row and type at cell A1 : Home Furniture Sdn. Bhd Payment Salary (Jan-

March 2020), then Merge and Center the text. 

(Right click on Row label > Insert) 

 

Home Furniture Sdn. Bhd Payment Salary (Jan - March 2020) 

Staff 

Number 
Name Basic Salary 

Overtime 

Jan 

(hour) 

Jan 

Overtime 

Feb 

(hour) 

Feb March 

M001 Riduan Ahmad RM2,300.00 6   10     

F023 Asyikin Arif RM1,800.00 4   8     

F030 Alia Zulaikha RM2,500.00 6   8     

M012 M.Sarajeevan RM1,900.00 8   12     

F028 Che Zaiton Mohd  RM1,500.00 12   10     

M035 Alif Fitri RM2,000.00 8   11     

M040 Zakuan Idham RM2,200.00 10   6     

F001 Mastura Ismail RM2,150.00 8   12     

M009 Wan Mohd Hafiz RM1,700.00 12   9     

F026 Mawar Danish RM2,150.00 9   13     

 

5. Calculate the employee’s salary for Jan, Feb and March. Refer the conditions below : 

 

Overtime Jan : RM50 per hour 

Overtime Feb : RM80 per hour 

March : Bonus 10% from the basic salary 

 

Notes : 

Salary = Basic salary + overtime payment 
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TASK 4 : 

1. Copy the Task 3 to a new sheet. Then rename it as Task 4 

2. Add a new column as the table below.  

3. Use the formula of IF to find out the Remarks of each staff either the staff is 

HARDWORKING STAFF or MODERATE STAFF. If the amount of overtime is 20 hours 

and above, the status of the staff is “Hardworking Staff”. Otherwise, it's “Moderate 

Staff. 

4. Create a column chart of the employee’s salary for Jan, Feb and March. 

 

Home Furniture Sdn. Bhd Payment Salary (Jan - March 2020) 

Staff 

Number 
Name Basic Salary 

Overtime 

Jan 

(hour) 

Jan 

Overtime 

Feb 

(hour) 

Feb March Remarks 

M001 Riduan Ahmad RM2,300.00 6   10       

F023 Asyikin Arif RM1,800.00 4   8       

F030 Alia Zulaikha RM2,500.00 6   8       

M012 M.Sarajeevan RM1,900.00 8   12       

F028 Che Zaiton Mohd  RM1,500.00 12   10       

M035 Alif Fitri RM2,000.00 8   11       

M040 Zakuan Idham RM2,200.00 10   6       

F001 Mastura Ismail RM2,150.00 8   12       

M009 Wan Mohd Hafiz RM1,700.00 12   9       

F026 Mawar Danish RM2,150.00 9   13       
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TOPIC 3.0 : PRESENTATION 

 

INTRODUCTION OF MS POWERPOINT 

Ms PowerPoint User Interface 
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 Quick Access Toolbar 
Enables you to customise the toolbar to contain the 
commands you use most frequently. 
 

File Tabs (Backstage View) 

Provides access to basic commands such as New, Open, 
Save, Print and Share plus access to customise the 
application. 
 

Ribbon 
Displays the numerous functions and tools available to work 
with your presentation. 
 

Title bar 
Displays the name of the application and the file currently in 
use. 
 

Slides Pane 
Displays a thumbnail version of each slide within the 
presentation. 
 

Slide Area 
The area which will be displayed as full screen when viewed 
in Slide Show mode. 
 

Placeholder 

Displayed as dotted lines which allows you to identify where 
you can add text, and insert elements such as images or 
tables. 
 

Notes Pane 

this is where the speaker notes are written for the current 
slide. Note that none of this content is visible on the actual 
slide while presenting 
 

View Button 

There are three view buttons on the Status Bar displayed 
towards the left of the zoom-in and zoom-out options: 
 
Normal: If you are in some other view such as Slide 
Sorter view, click the Normal button on the Status Bar to 
switch to Normal view. Shift-clicking this button gets you 
to Slide Master view. 
 
Slide Sorter:  The Slide Sorter view displays zoom-able 
thumbnails of every slide in the open presentation. Shift-
clicking this button gets you to Handout Master view. 
 
Reading View: This button to switch from any other view 
to Reading view. 
 
Slide Show: Show the presentation as a full screen slide 
show from the current selected slide.  
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EXERCISE 1 

(Create new slide presentation, perform graphics elements, perform text features) 

 

Create a presentation that consists of 5 slides.  

SLIDE ONE:  

Title: “The Seasons”  
Subtitle: BY: “Your Name”  
 

SLIDE TWO:  

Title: SPRING 
  

 March 20th is the first day of Spring  

 Spring lasts from March to June  

 Temperature transition from winter cold to summer heat 
 

SLIDE THREE:  

Title: SUMMER  

 June 20th is the first day of Summer  

 Summer lasts from June to September  

 Many people in rich countries travel in summer, to seaside resorts, beaches, camps or 
picnics.  
 

SLIDE FOUR:  

Title: AUTUMN  

 September 22nd is the first day of Autumn  

 Autumn lasts from September to December  

 Days become shorter and nights longer. Also the moon is brighter in this period of year 
and also some new stars can be visible. 
 

SLIDE FIVE:  

Title: WINTER  

 December 21st is the first day of Winter  

 Winter lasts from December to March  

 Trees and plants usually go dormant or else die so when you look outside, you’ll see more 
brown than green. 

 

https://simple.wikipedia.org/wiki/Travel
https://simple.wikipedia.org/wiki/Seaside_resort
https://simple.wikipedia.org/wiki/Beach
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EXERCISE 2 

(Create new slide presentation, perform graphics elements, perform media elements, 

perform slide elements, use hyperlink features) 

 

As a competitive entrepreneur, you want to market your food products to a business 

premise. Create a presentation slide to present your product to the company. 

 

Content Slide Descriptions 

Presentation Title Title of your presentation 

Introduction Introduction of your business/products 

Products -Give at least 5 types of your food product including picture 

-Show the product’s nutrition in chart 

Marketing strategy -Explain your marketing strategy 

-Create hyperlink to social media, etc 

Advantage -What are your business advantages 

-Explain why the company needs to use your product 
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TOPIC 4.0 : PROJECT MANAGEMENT 

 

INTRODUCTION OF MS PROJECT 

Microsoft Project User Interface 
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 Quick Access Toolbar 

The Quick Access toolbar gives you quick access to 
frequently used commands. This toolbar is completely 
customizable and can be positioned above or below the 
ribbon commands. 
 

Tabs 
Groups of like commands are organized under tab names. 
Click a tab to view the commands in the ribbon. 
 

Ribbon 
Displays tab commands organized into groups. If you click 
the different tabs, you will see the commands change. 
 

Timeline View 
Displaying a bird eye view of the project. It is optional and 
can switched on or off. 
 

View Bar 
Displaying name of current view 
 

Main Area 

There are two main area : 

 Table containing data relevant to current view 

 Graph relevant to current view 
 
The default Gantt Chart view shows task name, duration of 
each tasks, start and finish dates, predecessors and 
resource name in the table on left hand side while right side 
shows a bar graph called Gantt Chart. 
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EXERCISE 1 

(Create a project plan, entering and managing task and subtask, entering the predecessor, 

entering the resources, assigning resources to task, perform gantt chart views, formatting 

and printing features) 

 

Blackcherry Computer designs and manufactures high tech devices for public consumption. 

Currently, the Blackcherry executive team is considering the development of a new version 

of their popular smartphone. As with all their products, they intend to design the 

smartphone to meet current trends and manufacture the device in house to maintain 

quality standards. 

Using information below, create a gantt chart of Smartphone Design Project. Your start date 

of the project is 1st April 2020.  

 

Task Name Duration Predecessors Resource Names 

PROJECT : DESIGN NEW SMARTPHONE  
 

  

   FEASIBILITY STUDY  
 

  

      Feasibility of software interface design 7 days 
 

 En. Ahmad 

      Feasibility of system functionalities 7 days 3  En. Kamarul 

   FUNCTIONAL SPECIFICATIONS 
  

  

      Functional requirement specification 5 days 4  Pn. Fazlina 

      Functional specification document 5 days 4  Pn. Fazlina 

   DEVELOP MARKETING PLAN 
  

  

      Forecast market plan 7 days 7  En. Kamal 

      Analyze sales and marketing metrics 10 days 9  Pn. Siti 

      Develop digital campaign 6 days 10  Pn. Aini 

   DESIGN MANUFACTURING PROCESS  
 

  

      Stock definition 7 days 7  Mr. Chong 

      Material selection 10 days 9  Mr. Raja 

      Manufacturing strategy 10 days 9  Pn. Alina 

   DETAILED SMARTPHONE DESIGN  
 

  

      Screening ideas 7 days 15  En. Ahmad 

      Materials requirement planning 6 days 17  En. Kamarul 

      Product design specification 10 days 18  Mr. Raja 

      Feature modelling 8 days 19  Pn. Aini 

   PROTOTYPE TESTING  
 

  

      Illustrate the system to users 14 days 20  En. Kamal 

      Get the feedback 10 days 22  En. Kamal 

      improve the system 10 days 23  Mr. Raja 

   FINALIZE PRODUCT DESIGN 
  

  

      Finalize design to meet user 
requirement 

7 days 24  Pn. Aini 
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   ORDER MANUFACTURING EQUIPMENT  
 

  

      Order equipment from supplier 8 days 26  En. Hafiz 

   INSTALL EQUIPMENT  
 

  

      Install the smartphone equipment 2 days 28  Pn. Alina 

   LAUNCHING  
 

  

      Launching the new smartphone design 1 day 30  En. Ahmad 
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LAB WORK
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LAB WORK 1 

TOPIC : WORD PROCESSOR 

 

1. Type the article below and make it 3 columns. One paragraph is for one column. 

Setting your page layout as Landscape orientation 

 

Interesting Facts about Malaysia 

The Malaysia Flag 

Popularly known as Jalur Gemilang. It was adopted on September 16, 1963. The Malaysia 

flag was designed by Mohamed Hamzah, 29 years old Public Works Department architect in 

Johor Bahru. 

Meaning and symbolism: 

i) 14 stripes : represent the equal status in the federation of the 13 member states. 

ii) The crescent represent Islam, Malaysia’s official religion. 

iii) The blue canton represent the unity of the Malaysian people. 

iv) Yellow is the royal color of the Malay rulers 

 

Nasi Kandar 

A dish unique to Malaysia and brought the immigrating Indian Muslims. The best in Penang 

and everyone has their favorite dishes. 

Penang’s three best Nasi Kandar Restaurants: 

 Line Clear Nasi Kandar 

 Liqayat Ali Nasi Kandar 

 Pelita Nasi Kandar 

 

Multi-racial Country 

Malaysia stand out in the world as an example of how different ethnic communities can live 

in peace and harmony. Malaysia is a multi-racial country consisting of Malays, Chinese, 

Indians and numerous indigenous people. 

Malay  : 67.4% 

Chinese : 24.6% 

Indian : 7.4% 

Others : 0.6% 
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2. Insert page border to your document 

3. Insert one picture for each interesting facts about Malaysia 

4. Insert Caption for each picture 

5. Insert Drop Cap in the beginning of each column. 

6. Type the title of the article by using Word Art 

7. Change the numbering in ‘The Malaysian Flag’ column into bullets 

8. Change the bullets in ‘Nasi Kandar’ column into numbering 

9. At column ‘Multi-racial Country’, show multi-racial ratio in the form of a pie chart 

10. Insert footnotes for each fact as below. 

Footnote for : 

The Malaysia Flag : source from www.wikipedia.org 

Nasi Kandar  : source from www.penang.ws 

Multi-racial Country : Department of Statistics Malaysia 

 

 

TASK MARKS 

Column & Landscape orientation 1 

Page border 1 

Insert picture (3 pictures) 1 

Insert Caption for each picture 1 

Insert Drop Cap (3 drop cap) 1 

Word Art (title) 1 

Change to numbering 1 

Change to bullets 1 

Pie chart 1 

Insert footnotes (3 footnotes) 1 

Total     /10        

 

 

 

 

 

http://www.wikipedia.org/
http://www.penang.ws/
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LAB WORK 2 

TOPIC : SPREADSHEET 

 

1. Create a new file, save as Exercise Excel.     (1 m) 

2. Type the data below (start on cell A1)     (5 m) 

3. Rename the sheet 1 as Labwork 2a      (1 m) 

 

 

4. Merge and center the title       (1 m) 

5. Apply a border for the table       (1 m) 

6. Insert a new column after PURCHASES PRICE /PCS and named it as TOTAL 

PURCHASES         (1 m) 

7. Insert a new column after SALES PRICES /PCS and named it as TOTAL SALES  

(1 m) 

8. Use formula to calculate : 

i) TOTAL PURCHASES of each product     (2 m) 

ii) TOTAL SALES of each product      (2 m) 

iii) TOTAL for TOTAL PURCHASES and TOTAL SALES   (2 m) 

iv) PROFIT         (2 m) 

 

9. Use the formula of IF to find out the status of each product either the product is 

SOLD OUT or AVAILABLE by making comparison between NUM OR SALES and NUM 

OF PURCHASE 

(3 m) 
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10. Insert the column chart as below      (3 m) 
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LAB WORK 3 

TOPIC : PRESENTATION 

 

You need to deliver a presentation about comparison of fast food products in Malaysia. Your 

slide presentation must include suitable design template, transition and animation. 

 

SLIDE CONTENT DESCRIPTIONS 

Presentation Title Title of your presentation 

Introduction Introduction of the fast food product 

Comparison between the product i) Explain product nutrition of each 

product, then compare between 

the product. 

ii) Comparison price 

iii) Comparison of product’s 

promotion 

 

Hyperlink Create hyperlink to the related page 

/website 

Conclusion Conclude the comparison results. 

 

Marks Scheme : 

TASK MARKS 

Suitable design template /2 

Suitable transition /2 

Suitable animation /2 

Presentation title /2 

Introduction /2 

Explain product nutrition /2 

Comparison price /2 
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Comparison of product’s promotion /2 

Create hyperlink /2 

Conclusion /2 

TOTAL MARKS /20 
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LAB WORK 4 

TOPIC : PROJECT MANAGEMENT 

In conjunction with your upcoming birthday, your parents have dedicated you to decorating 

your bedroom. Therefore, to make sure that the renovation of the room is going smoothly, 

you need to schedule your planning in detail. 

Using information below, create a gantt chart of your new room. Your start date of the 

project is 1st December 2020. Please assign the suitable resource names regarding each task. 

 

Task Name Duration Predecessors 

PROJECT : My New Room  
 

   EMPTY ROOM  
 

      Move out old furniture 5 days 
 

      Take down the curtains 1 day 3 

      Remove the curtain pole 1 day 3 

      Vacuum the cobwebs 2 days 5 

   PREP ROOM 
  

      Paint the wall 3 days 6 

      Hang the wallpaper 2 days 8 

      Fit a new curtain poles 1 day 9 

      Buy new furniture 7 days 6 

   INSTALL NEW APPLIANCES 
  

      Install a new wardrobe 2 days 11 

      Move in new furniture 3 days 13 

      Hang in new curtain 1 day 14 

   INSPECT ALL WORKS  
 

      All work done and finish 1 day 15 

 

Marks Scheme : 

TASK MARKS 

Able to indent and outdent the task and sub task /2 

Correct to insert the start date /2 

Correct to insert duration /2 

Correct to insert predecessors /2 

Assign resource name of each task /2 

Total /10 

 


